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ETABS® 2013 Version 13.1.1 
Release Notes 

© Copyright Computers and Structures, Inc., 2013 

Release Date: 2013-07-22 

 
 
This file lists all changes made to ETABS since the previous version. Most changes do not affect most users. 

Incidents marked with an asterisk (*) in the first column of the tables below are more significant and are included in the 
ReadMe file. 
 
Version 13.1.1 was released shortly after v13.1.0 to correct a problem inadvertently introduced in v13.1.0. For this 
reason the Release Notes for v13.1.0 are also included in this file. 
 

Changes from v13.1.0 (Released 2013-07-10) 

 

Section Designer 

Enhancements Implemented 
* Incident Description 

 55515 An option has been added to the copy command for PMM curve data from within Section Designer 
so that the P-M curves at different angles can be arranged either horizontally (row-wise) or 
vertically (column-wise) when pasted to another location. 

Database Tables 
Enhancements Implemented 

* Incident Description 

 55960 The table for computed story stiffnesses is now exposed for all license levels and for all design 
codes. Previously, it was available only for the special Chinese version. 

 
 
 

Modeling 
Incidents Resolved 

* Incident Description 

 55354 An incident was resolved in which Section Designer sections could not be added to steel auto select 
lists. This capability was available in v9 and has been restored for ETABS 2013. 

* 55934 An incident was resolved that addressed three issues for the layered shell: (1) The thickness 
reported for a layered shell property was not correct. Now this has been changed to represent the 
distance between the extreme outer surfaces of the combined layers. (2) The mass computed from 
the layers was sometimes reported incorrectly in the tables. The mass used for analysis was correct. 
(3) The automatic modeling of embedded beams for connectivity with frame objects has been 
removed. This was used to provide good moment continuity between frame objects and the out-of-
plane (drilling) degrees of freedom for the shell elements, which has no stiffness for the layered 
shell. However, the definition of the beam properties was not realistic for all cases. The user should 
manually model embedded beams to achieve continuity based on their knowledge of the expected 
behavior of the structure. Automatic modeling of embedded beams for homogeneous shell wall 
elements is still provided and has not been changed. 
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Analysis 
Incidents Resolved 

* Incident Description 

* 53383 An incident was resolved in which the equivalent properties of waffle and ribbed slab property 
types were not being correctly calculated. This only affected waffle and ribbed slabs modeled using 
these new property types introduced in v13.0.0. The slab self-weight and stiffness for these property 
types was incorrect and the error was obvious. 

 55540 An incident was resolved in which analysis instability error messages were generated for certain 
models when auto-lateral wind loads were applied. 

* 55817 
55878 

An incident was resolved where sometimes the analysis model could not be created and results were 
unavailable. This would happen under certain conditions where the number of frame objects or the 
number of shell objects was larger than the number of joints and internal meshing was involved. 
This error was inadvertently introduced in v13.1.0 and only affected this version. 

Frame Design 
Incidents Resolved 

* Incident Description 

 55811 An incident was resolved where the values for VEd2 and VEd3 were not reported correctly in the 
table "Shear Design" for the Italian NTC 2008 and Eurocode 2-2004 concrete frame design codes. 
This was only a reporting issue. The correct values were being used for design and no results were 
affected. 

* 55860 An incident was resolved where the frame design would not consider a multi-valued load case in a 
design combination if step-by-step results were requested but the particular case was not the last 
case in the combination. This error did not occur if enveloping results were requested or the case 
was not multi-valued or the case was the last one listed in the combination definition. 

 55984 An incident was resolved for steel frame design using the AISC 360-10 code where the special 
seismic load combinations were not being considered for the columns of moment frames in the 
case where axial compression satisfied the limit Pu/phi*Pnc < 0.4. This exclusion was permissible 
for AISC 360-05 but is no longer applicable for AISC 360-10. The previous results could be 
unconservative. 

 55986 An incident was resolved for steel frame design using the IS 800-2007 code where the calculated 
Cm factors could be incorrect for the first station of any member that was in compression, which 
could affect the PMM interaction ratio. This occurred when the previously designed member was 
in tension, or if no previous steel frame design was performed in that session of ETABS. When 
this error occurred, the member was assumed to be in tension at that station for the purpose of 
calculating the Cm factors at that station, in which case they were assumed to be unity. This error 
was conservative. 

* 56057 An incident was resolved for steel frame design using the AISC 360-05 and AISC 360-10 codes 
where the special seismic loading combinations required to amplify the seismic loads for certain 
type of members were not being applied. This error was inadvertently introduced in v13.0.0. 

Shear Wall Design 
Incidents Resolved 

* Incident Description 

* 55875 An incident was resolved where spandrel flexural design was in error for Turkish TS 500-2000 
code. The GammaC and GammaS factor for material strength reduction were both incorrectly used 
as 1.11 instead of 1.5 and 1.15 respectively. The previous results could be unconservative. 
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Results Output and Display 
Incidents Resolved 

* Incident Description 

 53538 An incident was resolved where the pier/spandrel forces for response-spectrum loading were being 
reported with signs, whereas they should always be positive. The absolute value of the results was 
correct. 

Detailing 
Incidents Resolved 

* Incident Description 

 55882 An incident was resolved in which the detailer would sometimes generate a runtime error when 
running for the first time after starting ETABS. Saving and reopening the model without closing 
ETABS would allow the detailer to run. No results were affected. 

Database Tables 
Incidents Resolved 

* Incident Description 

 55992 An incident was resolved where some of the provided verification examples produced a warning 
message when run indicating that table results could not be exported because the expected folder 
could not be found. This has been changed so that the automatic table export file specified using the 
command Analyze > Set Load Cases to Run will be written to the folder where the model file is 
located if the specified folder cannot be accessed or if no folder path is given.  

External Import/Export 
Incidents Resolved 

* Incident Description 

 55981 An incident was resolved where the export of load cases to IFC would generate error messages 
when no load combinations were present. No results were affected. 

Miscellaneous 
Incidents Resolved 

* Incident Description 

 55908 The version number was changed to v13.1.1 for a new minor release. 
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ETABS® 2013 Version 13.1.0 
Release Notes 

© Copyright Computers and Structures, Inc., 2013 

Release Date: 2013-07-10 

 
 
This file lists all changes made to ETABS since the previous version. Most changes do not affect most users. 

Incidents marked with an asterisk (*) in the first column of the tables below are more significant and are included in the 
ReadMe file. 

Changes from v13.0.0 (Released 2013-04-17) 

User Interface 
Enhancements Implemented 

* Incident Description 

* 53254 An enhancement has been implemented to allow customization of the keyboard shortcuts for the 
various menu items. These keyboard shortcuts and the toolbar settings are saved in the local user 
folder so that settings are maintained with each use of the program. 

Modeling 
Enhancements Implemented 

* Incident Description 

 53076 Frame section properties have been enhanced to separate steel shapes from concrete shapes. The 
following steel shapes are now available: Tee, Angle, Box/Tube, Pipe, Channel, Double Angle, 
Double Channel, and I. The following concrete shapes, including rebar, are now available: Tee, L 
Shape, Tube, Pipe, and Cross. 

 54762 An enhancement was made to the Load Case Data form in which a note describing the units used 
for the scale factor item in the Loads Assigned table was added. The scale factor units can vary 
depending on whether the assigned load is a load pattern, acceleration or other type of load. 

 55205 An enhancement has been made to provide users separate controls in the mass source definition for 
including or excluding self-mass from elements and added masses, in addition to the use of load 
patterns. Previously self-mass and added mass were considered together. 

Loading 
Enhancements Implemented 

* Incident Description 

 53387 
53390 

Repeated warnings messages that were previously displayed for building heights exceeding certain 
code limits for automated wind loading have been removed and replaced with a single warning 
message. 

* 53532 Automated wind loading has been added according to the Australian and New Zealand code 
AS/NZS 1170.2-2011. 

 54433 An enhancement was added for automated wind loading using the diaphragm-extents option for the 
ASCE 7-02, ASCE 7-05 and ASCE 7-10 codes that now allows automatic determination of the 
wind pressure coefficients (windward and leeward) based on the building size. 
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Frame Design 

Enhancements Implemented 
* Incident Description 

 34602 Steel frame design using the "AISC 360-05" and "AISC 360-10" codes have been enhanced to use 
the minimum D/C ratio from the two alternative AISC code sections H1.1 and H1.3 for the case of a 
doubly symmetric section with axial compression and major axis bending moment but with no 
minor axis bending moment. Previously for these conditions the AISC section H1.3 was always 
used, which can be over-conservative. The use of section H1.1 is not mandatory. For normal design 
or design-checks with a D/C ratio limit of 1.0, this enhancement has no effect. However this 
enhancement may affect some acceptability checks for performance-based design with a target D/C 
ratio greater than 1.0. 

 42783 An enhancement is added for steel frame design using the AISC 360-10 code which provides a 
option to allow Notional Load cases to be included in design combinations with wind, seismic and 
response spectrum cases. 

* 53544 Concrete frame design and shear wall design have been added for the Hong Kong CP 2013 code. 

Database Tables 
Enhancements Implemented 

* Incident Description 

 53732 
54059 

New database tables have been added that provide pier and spandrel section property information. 
These tables are equivalent to those that were present in ETABS v9. 

External Import/Export 
Enhancements Implemented 

* Incident Description 

 52919 The import and export of IFC files has been enhanced as follows: (1) When duplicate frame 
elements are detected during the import of an IFC file, a warning is issued. If there is both a 
structural view frame object and its architectural equivalent at the same location in the IFC file, only 
the structural object is imported. (2) Improved handling of end releases, offsets, and loads for IFC 
frame members having orientation reversed of the ETABS default. (3) Assignment of members to 
story levels at export. (4) File schema updated to IFC4 at import and export. The 2x2, 2x3, 2x4, and 
IFC4RC4 schemas can also be imported; later versions of IFC4 are not currently supported. (5) 
Unique story names are created in ETABS for duplicate story names in the IFC file with different 
elevations. (6) The import of arc slabs is now supported. (7) The log file has been expanded and 
enhanced recording errors, warnings, and messages during import and export. 

Documentation 
Enhancements Implemented 

* Incident Description 

 18881 The Lateral Loads Manual has been updated to describe the use of Parapet Wind pressure for the 
ASCE 7-02 and ACSCE 7-05 codes. This is a change to the documentation only. 
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User Interface and Display 
Incidents Resolved 

* Incident Description 

 40795 An incident was resolved in which it was not possible to step through the defined load patterns 
using the back/forward buttons in the status bar when displaying loads on the model. 

 53194 An incident was resolved where the various code-based auto-lateral loads could not be selected 
when defining "Wind" and "Quake" load patterns when the Turkish language setting was used on 
the computer system.  

 53419 An incident was resolved in which disabled forms (when the model is locked) containing a grid of 
data could not be scrolled in order to view all of the data in the grid. 

 53474 An incident was resolved in which the snap to grid intersections did not always work for certain 
gridline arrangements. 

 53523 An incident was resolved in which the tooltips that are shown when hovering over objects in a 
model window would sometimes show the same information twice in a single tooltip. This was a 
display issue only and did not affect results. 

 53963 An incident was resolved in which the fillet weld symbol was shown in the incorrect orientation on 
some of the steel connection preferences and overwrites diagrams. 

 53968 An incident was resolved in which the auto-seismic period calculation method did not save after 
changing it in the form. It would instead reset to Program Calculated and the results would reflect 
this. This affected only the ASCE 7-05 and ASCE 7-10 seismic loading codes. 

 54036 An incident was resolved where pasting data into the Grid System Data form to define the grid 
locations did not always work as expected. In addition, pasted data was restricted to the number of 
rows present on the form, not allowing additional rows to be added. 

 54278 An incident was resolved where deleting points from the multilinear force-displacement data for a 
multilinear link element corrupted the force-displacement data. 

 54578 An incident was resolved where some very large data files may not be able to be reopened due to 
insufficient memory. 

 54688 An incident was resolved where a single click in a plan view was sometimes selecting multiple 
objects if an alternate grid system was selected in the grid drop-down box. 

 54854 An incident was resolved where the coordinates shown on the status bar were sometimes off by 
small amounts. This was a snapping issue which has been corrected. 

 55008 An incident was resolved where sorting of the general grids by the Y1, X2, and Y2 coordinates was 
enabled inadvertently. General grids should only be sortable by ID, not by coordinate. No results 
were affected. 

 55062 An incident was resolved where opening a model from an older version of ETABS (v9.7.4 or 
earlier) that contained certain frame general sections could cause the drawing of new frame 
members to fail. 

 55282 An incident was resolved where the hysteresis type for multilinear plastic link properties was 
always displayed as kinematic whenever the property definition form was opened. Whatever 
hysteresis type was chosen by the user would be used for analysis when the OK button on the form 
was clicked, and the results agreed with the model. The type used could be seen in the text data file 
(*.$ET or *.E2K). 

Graphics and Drafting 
Incidents Resolved 

* Incident Description 

 29394 An incident has been resolved where drawing walls over multiple stories would sometimes result in 
an exception (runtime error). 

 53086 An incident was resolved where the extruded view of circular arcs was being displayed as a full 
circle or was otherwise incorrectly displayed in cases where the arc was not in a horizontal plane. 

 53500 An incident was resolved in which replication by story of walls would sometimes result in the 
graphics showing diagonal lines on the walls. This was a graphics issue only. 



ETABS 2013 v13.1.0 2013-07-10 Page 4 

* Incident Description 

 53362 An incident was resolved in which the reshape tool was not using the parallel to X or Y drawing 
control types. In certain cases, using the reshape tool to merge two area object points caused the 
area object to be removed. 

 53720 An incident was resolved where showing extruded areas would sometimes generate an incorrect 
display for certain models. This was a display issue only. 

 53876 An incident was resolved where shell objects would sometimes disappear from view when zooming 
in a model window with soil-pressure results displayed. This was a graphical issue only. No results 
were affected. 

 53944 An incident has been resolved in which the extruded view of some slabs with curved edges did not 
display. This was a display issue only. 

 54053 An incident was resolved in which the deck span indicator drawn on the model was sometimes very 
large. 

 54265 An incident was resolved in which the scaling of pier force diagrams was sometimes incorrect when 
using automatic scaling. This was a display issue only and did not affect results. 

 54518 An incident was resolved in which toggling the architectural dimensioning option did not change 
the formatting of the dimension line text. This text always displayed in architectural format when 
using U.S. units. In addition, an option has been added that provides control of the precision of the 
architectural dimensioning. 

 54908 An incident was resolved in which unchecking the Object Fill view option did not turn off the fill 
for walls. 

 55520 An incident was resolved where display of frame uniform load was incorrect on curved frames. 

Modeling 
Incidents Resolved 

* Incident Description 

 53125 An incident was resolved where a curved frame object may have an incorrect geometry or location 
depending upon how it was drawn or edited. 

 53452 An incident was resolved where the building of models using an imported architectural layer was 
not always working correctly, particularly by snapping to the wrong locations while drawing 
objects. The errors, when they occurred, were obvious. 

 53512 An incident was resolved in which using the divide frames or divide shells commands while the 
similar stories or all stories option was turned on would generate additional objects at the other 
stories. 

* 53758 An incident was resolved where using the Edit > Frame > Divide Frames command would result in 
applied point and distributed loads on frames being duplicated in each of the new segments. This 
modeling error is limited to editing done in V13.0.0 only. 

 53811 An incident was resolved where the message “Error getting display units data” may appear when 
assigning a second auto PMM steel hinge to a frame object. 

 53906 An incident was resolved in which opening a model that contained certain types of Section Designer 
sections would cause an error when trying to save the model. 

 53940 An incident was resolved in which the reshape handles for editing walls were sometimes too large 
or too small. 

 53981 An incident was resolved in which objects on other stories were not being modified when using the 
reshape tool with the All Stories or Similar Stories option selected. Only the objects on the single 
floor selected were being modified. 

 54730 An incident was resolved where replication of wall objects in some instances would add 
unnecessary lines to the display. This was a display issue only. 

 54943 An incident was resolved in which using the Edit > Edit Shells > Divide Shells command with the 
option Intersections with Selected Frame Objects would sometimes generate duplicate or new shells 
where not expected. 
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Section Designer 
Incidents Resolved 

* Incident Description 

* 52881 An incident was resolved for Section Designer where the section properties were sometimes 
calculated incorrectly for a filled pipe due to an internal tolerance issue. When this occurred the 
error was obvious and the section properties were usually zero. 

 53582 An incident was resolved in the section designer in which setting the 'Mirror About 2' value to Yes 
for a channel section would sometimes cause the Section Designer Section Property Data form to 
not accept the OK button and therefore the section couldn't be saved. 

 53794 An incident was resolved where certain ETABS v9 model files containing Section Designer frame 
sections could not be opened, resulting in an error message. This occurred when some edges of 
polygons in the Section Designer sections did not have reinforcement specified. This condition is 
now handled. 

 54170 An incident was resolved where a particular ETABS v9 model would not open. This error was 
limited to the presence of Section Designer sections which included pie or pie-arc shapes with 
negative subtended angles. 

 54637 An incident was resolved where some Section Designer sections would give a subscript out of range 
error when saving the model file. This was a rare case and was related to a section shape in a 
Section Designer section being deleted and getting corrupted. 

 55061 An incident was resolved where doubly symmetric concrete sections with symmetrical 
reinforcement were not producing identical yield strength in major and minor directions for use in 
frame hinges. Also, the moment curvature diagrams were not identical along the line of symmetry. 
This did not affect the PMM interaction surfaces used for design. 

 55077 An incident was resolved in which the concrete frame design results tables would not be filled if the 
design section had been overwritten. This was an issue for all design codes. The design results 
themselves were correct. 

Loading 
Incidents Resolved 

* Incident Description 

 53301 For the ASCE 7-10 Seismic Drift case, minimum base shear was previously being enforced 
according to ASCE 7-10 clause 12.8.5. This requirement is no longer enforced as per the exception 
of ASCE 7-10 clause 12.8.6.1. 

* 53304 An incident was resolved where the additional eccentricity specified for seismic loads (equivalent 
static or response spectrum) was not being correctly applied to the loads at joints that were part of a 
semi-rigid diaphragm. The primary translational loads were correctly applied. Seismic loads applied 
to rigid diaphragms were not affected. 

 55194 An incident was resolved for Eurocode8-2004 response spectrum function and the auto-seismic load 
pattern where function was not being saved or was saved with zero parameters when country type 
was set to "Other". 

 55477 An incident is resolved for Turkish Seismic Code response spectrum function where selecting 
Seismic Zone 2 was using the A0 factor as 0.4 instead of 0.3. This always produced conservative 
results. 

Analysis 
Incidents Resolved 

* Incident Description 

 52738 An incident was resolved where "Do Not Run" option was not enforced correctly for Sequential 
Analysis case. No results were affected. 

 53226 An incident was resolved where the modal directional factors were not calculated correctly for 
structures where either (1) the centers of mass for all rigid diaphragms were not located in a single 
vertical line, or (2) some of the joints with mass were not included in rigid diaphragm constraints. 
The directional factors are now calculated correctly regardless of the location of the diaphragms, but 
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* Incident Description 

only mass at joints included in rigid diaphragms will be considered. Note that this excludes semi-
rigid diaphragms. Including mass that is not part of a rigid diaphragm is not defined for directional 
factors, and can lead to an overestimation of the translational factor and an underestimation of the 
torsional factor. Now, the sum of the directional factors will be less than unity when some of the 
mass exists at joints that are not included in rigid diaphragm constraints. 

 53343 An incident was resolved where the use of modal damping interpolated by period in a response-
spectrum or modal time-history load case was actually using interpolation by frequency between the 
specified values. This means that the damping values were correct at the specified period values, but 
the interpolation between the specified values was proportional to f = 1/T, rather than to T. Here T 
is period and f is cyclic frequency. The effect of this error upon the results was generally 
insignificant. 

 53570 An incident was resolved where property modifiers assigned via Shell Section definitions were not 
also being applied to the internal beams added (when needed) to walls for the purpose of providing 
continuity with frame elements. This did not affect property modifiers assigned directly to the walls, 
only those assigned to the wall property. The effect of this error was generally insignificant. 

 53752 An incident was resolved where groups containing area objects that were auto-meshed and that also 
had edge constraints assigned did not always include the effect of the edge constraints when used in 
a nonlinear static staged-construction load case. This could have affected the local connectivity of 
the area objects, but overall equilibrium was maintained. 

* 54135 An incident was resolved where the out-of-plane (plate bending) behavior of the layered shell was 
not correct for the case where a frame object was connected to one of the joints of the shell. The 
reason for this is that ETABS extends the frame object into the shell to establish good continuity, 
but this behavior was incorrectly implemented for the layered shell. The homogeneous thin and 
thick shell objects were behaving correctly.  

* 54165 An incident was resolved where the tabular output for story mass was incorrect for models with 
multiple towers. This was only a reporting issue. 

* 54634 An incident was resolved where the results for structures modeled as multi-tower were obviously 
inconsistent and incorrect. This was due to duplication of some members in the analysis model. 

 55109 An incident was resolved where the assignment to NOT apply Edge Constraints was not being 
checked for wall type area objects. This meant that edge constraints were always being applied to 
wall objects that had mismatched meshes. 

Frame Design 
Incidents Resolved 

* Incident Description 

 26139 An incident was resolved in which steel frame design generates very large demand/capacity ratios 
when designing a nonprismatic section consisting of a standard steel section and a section designer 
section. 

 52285 An incident was resolved where the design type automatically detected for staged-construction 
load cases was always "Other". This has now been corrected. This could affect the proportion of 
shears and moments assigned to sway and non-sway cases when design combinations included 
staged construction cases. 

 53085 An incident was resolved where the building of models using an imported architectural layer was 
not working correctly. The errors when they occurred were obvious. 

 53207 An incident was resolved for concrete beam design where the table columns for reporting 
minimum rebar and required rebar were switched. This was only a reporting issue and design 
results were not affected. The affected codes are ACI 318-08, ACI 318-11, CSA A23.3-04, 
Eurocode 2-2004, Italian NTC 2008, Mexican RCD 2004, NZS 3101-06 and Turkish TS 500-
2000. 

 53624 An incident was resolved for concrete frame design using the Italian NTC 2008 code where the 
design report for columns was indicating "Seismic Load?" as "False" when the load combination 
contained seismic loading. This was a reporting issue only and the design results were not 
affected. 
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* Incident Description 

 54449 An incident was resolved where the Joist Design could be incorrect. When this occurred, the 
results were obviously incorrect as the capacity was shown to be infinite. The error was limited to 
design combinations that included multistep load cases. 

 54808 An incident was resolved for concrete frame design using the NZS 3101-06 code where the value 
for As,min was set to 0.25 * (sqrt(f’c)/fy) * Ac. Now As,min is set to the larger of 0.25 * 
(sqrt(f’c)/fy) * Ac and (1.4/fy)*Ac per the code (NZS 9.3.8.2.1). This change only affects beams 
which are lightly loaded and which use low-strength concrete for which the latter limit governs. 
This error has minor significance. 

 54906 An incident has been resolved for steel frame design using the Eurocode 3-2005 code in which the 
effective section properties of Class 4 Double Angle sections were incorrect under certain stress 
conditions. The stress condition occurred when (a) the minor axis moment was significant, (b) the 
stress at one of the tips of the flanges was identically zero and the stress at the other tip was 
compression under axial load plus minor-axis bending only. The error did not affect Double Angle 
sections for classes 1, 2, and 3. 

 55177 An incident was resolved for concrete frame design where the reported Minimum eccentricity M2 
and M3 were switched in Design Report. This affected all codes. This was only a reporting issue. 
The design was correct and no results were affected. 

 55277 An incident was resolved for concrete frame design using the EC 2-2004 and Italian NTC 2008 
codes where the minimum rebar requirement for beams (EC2 9.2.1.1(1)) was not being enforced. 

 55351 An incident was resolved for concrete frame design using the Italian NTC 2008 code where 
modulus of elasticity for concrete was being recalculated based on the equation "Ec = 100000 / 
(2.2 + 34.7 / fck)" instead of using the value specified for the material property. Now the value 
specified for the material will be used. This error was insignificant for practical design purposes. 

 55366 An incident was resolved where "Super DL + Live Load" status in Deflection report was not 
correctly handled in steel frame design when the deflection report was created. This was just a 
reporting error and design results were not affected. Program was comparing the "Super DL + 
Live Load" with Live Load Deflection Limit. 

 55545 An incident was resolved for concrete frame design using the TS 500-2000 code where the 
maximum compression limit for column design was always enforced as "0.5 fck Ac". However, 
the "0.5 fck Ac" limit should is only applicable to load combinations that contain seismic loading; 
other load combinations loads only should use the higher limit of "0.6 fck Ac". This has been 
corrected. The design results were always conservative for gravity combinations. 

Shear Wall Design 
Incidents Resolved 

* Incident Description 

 53305 An incident was resolved for shear wall design using the CSA A23.3-04 code where the 3D pier 
boundary zone was not being reported. 

* 53970 
55285 

An incident was resolved where in certain cases an incorrect pier section for shear wall design was 
being created when multiple wall objects in the same plane were assigned the same pier label. When 
this occurred the error was obvious because the wall area shown in the design report was clearly 
incorrect. 

 54733 An incident was resolved where the Spandrel Overwrite form was blank and the wall design report 
was not able to be generated when pier and spandrel labels were assigned to same wall. Now when 
both Pier and Spandrel label are used on the same wall, a selection form is shown to choose the 
appropriate display. 
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Connection Design 
Incidents Resolved 

* Incident Description 

* 54668 An incident was resolved in the baseplate design in which the minimum plate thickness calculation 
displays a square root symbol in the design details, but the calculated minimum thickness value is 
missing the square root. This could result in unconservative baseplate thickness. 

Detailing 
Incidents Resolved 

* Incident Description 

 54182 An incident was resolved in which an error was generated when trying to run the detailing for 
certain models. This could be avoided by saving and reopening the model. Now this is no longer 
necessary. 

 54331 An incident was resolved for the detailer where overwriting the rebar rules for seismic column tie 
spacing would result in the column schedule calling out ties at 0" spacing. 

Results Display and Output 
Incidents Resolved 

* Incident Description 

 53163 An incident was resolved where the command File > Create Video could become unresponsive 
depending upon the video codecs installed on the computer system. 

 53195 An incident was resolved in which the characteristic periods Ta and Tb for the Turkish EDP-2007 
auto seismic loading were being incorrectly reported in the seismic calculation report. This was a 
reporting issue only. The periods used to calculate the seismic load for analysis were correct. 

 53293 
53788 

An incident was resolved that addressed two issues with frame hinges: (1) The text export of certain 
FEMA356 auto-hinge assignments was incomplete and thus the text import did not reproduce the 
original hinge assignments. (2) The display of hinge results sometimes failed, and instead a large 
red X was plotted. 

 53730 An incident was resolved in which joint drifts were not reported for Seismic (Drift) type load 
patterns in the joint drifts table. This was a reporting issue only. 

 53766 An incident was resolved in which the auto seismic calculation in the report was showing the 
incorrect Ct values for the ASCE 7-05, ASCE 7-10, and Eurocode 8-2004 codes. This was a 
reporting issue only and did not affect results. 

 54017 
54627 

An incident was resolved where, in certain special cases, the Maximum Story Drift plots were 
incorrect. When this occurred the effect was obvious. No other results were affected. 

 54696 
54887 

An incident was resolved in which an error message was generated when right clicking on a 
designed pier to show the design details when the Pier Design option for that pier was set to 
"Simplified C&T Method". All wall design codes were affected. This was only a display issue 
where the error message was caused by trying to display the leg coordinates. Design results were 
unaffected. 

 54897 An incident was resolved where, in certain cases, the property data for deck sections was not saved 
with the model and would be reset to default values when the model was re-opened. 

 55136 An incident was resolved where the buckling shape was not correctly scaled if beam span loads 
were present. This was a display issue only and the buckling load factors calculated were correct. 
Beam span loads may cause buckling but should not affect the plotted shape of a buckling mode. 

 55156 An incident was resolved where Report Table for "Shear Design for VEd2, VEd3 were not 
populated correctly for Italian NTC 2008 and Eurocode 2-2004 design codes. This was just a 
reporting issue and did not affect the design. 
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Database Tables 
Incidents Resolved 

* Incident Description 

 53274 An incident was resolved in which an error was sometimes generated when trying to display or 
export the Program Control database table. This most often affected export to Access, which 
requires the Program Control table to specify the units. 

 53661 An incident was resolved in which trying to create a user report would sometimes appear to start 
generating a report but never complete. This could occur when there were problems generating the 
design results tables. 

 53837 An incident was resolved in which the steel-frame and composite-beam design results tables would 
not display values for certain models. This was a display issue only and did not affect results 
displayed elsewhere. 

 53905 An incident was resolved in which changes made by editing the table for frame end releases did not 
have any effect on the end-release assignments. 

 54386 An incident was resolved in which section cut definitions were not properly imported from the 
*.e2k text file. The effect of this was that results could not be displayed for imported section cut 
definitions. 

 54689 An incident was resolved where the units shown for the participation factors in the table "Modal 
Participation Factors" were given as [F-T2] for translational degrees of freedom (DOF), and as [F-L-
T2] for rotational DOF, whereas the units should be [F-L] for all DOF. The values shown in the 
table were correct in the database units of the model, but the translational values could be incorrect 
for other length units. Database units are those in effect when the model is first created. This error 
had no effect on any other results. 

 54911 An incident was resolved in which the Concrete Column PMM Envelope database table was 
showing the reinforcement quantity (length units squared) followed by a percentage sign when it 
should have been showing the reinforcement percentage. The on-screen display and the right-click 
design detail sheets were correct. 

 55336 An incident was resolved where the error message "Error switching within tables" was generated 
when viewing the Wall Pier Summary Table. This only occurred when the Uniform Reinforcing 
Pier option was selected for provided reinforcement. No design results were affected and the error 
was only in table display. 

Data Files (.EDB, .E2K, .$ET) 
Incidents Resolved 

* Incident Description 

 53880 An incident was resolved in which importing an ETABS v9 *.e2k file with mass source from self 
and specified mass and loads resulted in the mass source in ETABS 2013 including the self-weight 
case in the loads list, which caused the self-weight to be double counted in the mass source. 

 53958 An incident was resolved in which using the Save As command would unlock the original model (if 
locked), therefore deleting existing analysis and design results. 

 54147 An incident was resolved where joist section definitions exported to the *.e2k text file and imported 
back in were changed and were no longer correct. The results agreed with the new model as 
imported. 

 54443 An incident was resolved in which the geometry could be incorrect after importing a model 
containing inclined members from the *.e2k text file. 

 54675 
54897 

An incident was resolved where, in certain cases, the property data for deck sections was not saved 
with the model and would be reset to default values when the model was re-opened. 
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External Import/Export 
Incidents Resolved 

* Incident Description 

 53178 
53502 
54243 
55273 

An incident was resolved in which exporting to .DXF would generate an error message for certain 
models, causing the export operation to fail. No results were affected. 

 53190 An incident was resolved in which an error occurs when importing certain .DXF files as 
architectural plans. 

 53534 An incident was resolved where importing a .DXF file as an architectural layer would overwrite the 
name of the model. 

 54542 An incident was resolved where the material type of "Masonry" was not written out to the text file 
and therefore was imported as type "Other". 

 54879 An incident was resolved that addressed several issues with the CIS/2 file import and export: (1) If 
the CIS/2 file was written in feet units and the file included more than one CIS/2 
global_unit_assigned_context entity then the joint coordinates would not import correctly. (2) If 
column orientations in the CSI/2 file were specified as angles in degrees rather than as vectors then 
the column orientation would not import correctly. (3) If force units chosen in ETABS were 
kiloNewtons then the CIS/2 file exported would have the force units undefined. (4) Error reporting 
for the import of CIS/2 files has been improved. 

 55685 An incident was resolved that addressed several issues with the import of STAAD files: (1) STAAD 
Reference Load specifications were not recognized and not processed (2) STAAD Repeat Load 
specifications were recognized but not processed (3) LX and LY were not recognized as valid 
STAAD pressure and trapezoidal element load direction specifications. 

Documentation 
Incidents Resolved 

* Incident Description 

 52967 Minor documentation errors in the Verification manuals have been corrected, minor improvements 
have been made to some of the examples, and some example file names have been changed for 
consistency. The design results produced and reported by ETABS are correct. The reported results 
are not changed except where the model has been changed. Three new examples have been added 
for steel frame design. 

Miscellaneous 
Incidents Resolved 

* Incident Description 

 53054 The version number was changed to v13.1.0 for a new minor release. 

 

 


